Burger King Project Guide: Rigging~ Part 01

1 Make sure you're
® on the Animation

menu. M File Edit Create Select Modify Display Windows Key Playback Audio Visualize - Constrain  MASH

———— NLLECIRE (- o

Blend Shape O

Cluster

Curve Warp

Delta Mush
Outliner View Shading Ligt
Display Show Help * mTOT R

Tension
Solidify

Proximity Wrap

Select the "burger”
" 3D text.

——
i £ Wrinkle
= bottom_bun :

L L
ng

(@) defaultLightset : Naonling;

(@) defaultObjectset Mo,

Pose Space Deformation

Muscle

Proximity Wrap
ShrinkWrap
Wire

Cutliner
Display Show He

(1) defaultlightset

4. Make sure you
have "ffd1l attice”
created & selected.

Channels Edit Object Show

fidiLattice

Translate X
Translate ¥
Translate Z
Rotate X
Rotate ¥
Rotate Z
Scale X
Scale ¥
Scale Z
Visibility

2

104p3 J

U
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SHAPES
ffd1LatticeShape

5- Set the U Divisions
to 4",
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1 = While your lattice
is selected,
activate the command:
(right mouse click+hold)
Select “Lattice Point”.

2 s Now work from the
“top-y" camara vicw,
Don't usa perspective
or you wi | get REKI.
lols...

L\ =\ A

u Carefully select these
yellow points, They will
be used to manipulate
the overall shape of the
“burger” text.
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A\

1- With the yellow lattice 2. Scale the sides inwards
vertexs selected, by puiling o the “red”
press “r" shortcut sca e handle as shown.
to activate the scale Srale it the sides, like

tool. in the example.

+'| ACES 1.0 SDR-vi o Edit Object Show

3. Your model now should
look like this example.

Translate X 0O
TranslateyY 0O
TranslateZ 0
RotateX 0O
Rotatey O
RotateZ 0O
ScaleX 1
Sealey 1
ScaleZ 1
Visibility on

10)pg Jade] f Hog BUUELD

Poly Modeling

SHAPES
burgerShape

4. Now select your "burger” polygon mesh & delete
it's history. If you don't remember how.. Google it!
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na* - Autodesk MAYA 2022.4: C\Users\DS\Documents\maya'pr

1. Now select the “king” H- s e | 2' Selectyour Tallattice.

Qutliner
Display
% 3D polygon mesh. b e T Blienet
= You will perform the Oustr
urve Warp

. lattice procedure - e
derer Par O

for this asset too, & EET T o

imagePlane1

<% bottom_bun
3= burger T —
v

\@l) defaultli

(@) defaultObjectset

Channels Edit Object Show

Wrap ffd1Lattice
Translate X
Translate

Translate Z

ShrinkWrap

Scale¥ 3.
Scale Z
Visibility
SHAPES
ffd1LatticeSh =

3 = Select the yellow dots, L
then scale them in,

l'.lr"l
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/ 1- Your "king" 3D polygon 2- Delete the "history” for
should look like this. wr “king” 3D model.

nimation Rendering

Channels Edit Object Show

king
TranslateX 0
Translate¥ 0O
TranslateZ 0O
RotateX 0
Rotate¥ O
RotateZ 0O
Scale X

10)pd Jade] f xog Buuey)

Scale ¥

Scale Z
Visibility  «
SHAPES

3- You may notice
strange visua' arufact
On the Sl ""QC\ { yb\... M BurgerKing_Delete History_Free
it 3[" Mol an. M File Edit Create Select

Modeling »* |
3a. Set the'Menu to
lodeling!

Mesh Display> Sl
)
>Soften/Harden Edge

Options Box>
set value to "15) then
Apply. M sor

Edit Help

Method: ® Angle
15.0000

Texture Barders

Soft/Hard Apply
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Burgerking_C story_Free
M File Edit Create Select : . A N
Jalize | Defarm | Constrain - MASH  Cache  Arold  Help

o Animation b o H hl - 0
_ I WG OB % bae sung an This is the @ andle”

Elend Shape

Cluster

Curve Warp

Delta Mush
derer Pan S
Tension

ez S

Lattice
Proximity Wrap
Wrap
ShrinkWrap

; horph
Wire
Wrinkle

Applying Bend Deformer~ Part 01

J=EA{E]

—
—1

1. Set Menu to "Animation”
2. Select "top_bun’
3. Deform> Nonlinear> Bend

e E ek

Pose Space Deformation
Muscle

Monlinear
5oft Modification Tool

f [gend.

sk A Flare

Texture
Jiggle
Point On Curve

= Sine

= Squash p Channels Edit Objed Show

_ - W Twist ’ bend1Handle

[_ .?-'!-'_!T-'---'_-_ai: 1 & wave i Translate X -0

EAit i - Translate ¥ 6.76.
Elend Shape TranslateZ -0
Lattice RotateX 0
Wrap Rntate ¥

RotateZ 90

Proximity Wrap 5 ¥: 9.185
: i " . Scale X

ShrinkWrap s == 4. "bendiHandle” will be created. ey 8185

5

5. Change "Rotate Z" to “90" Vistoity
SHAPES
bend1HandleShape

10ypg Jade] f xog BUuEyD

Curvature IC-
INPUTS
bend1

Envelope 1

Aﬂer Curvature 0
ums Low Bound -1

High Bound 1

nyjoo] Guyapop

SHAPES

s : Now test it out to see if it works.
el - Punch in the value of “20" for the
- Tl <« Curvature, and it should bend.
Curvature 20

Low Bouna -1 j If it works as shown, set the
igh Boun i i 1
on B Curvature” back to “0”.
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Creating 2nd “bend2Handle” for “top_bun"

1 m Select the “top_bun’
Channels Edit Object Show

Deform> Nonlinear> Bend . Sh _

Translate ¥

TranslateZ -0 GO tO Channe[ BOX
e = Change Rotate X & Y

h\

Cutliner
| Display Show Help

1o|pg ainguir

h o)

<%= bottom_bun
<%= burger

<%= king

3 Now let’s test them both ou?’
H .

urger

ff% bend2Handle Har
(#1) defaultlightSet bend2Handle |
(1) defaultObjectset Iyoes tiansigo k

(@) defaultlightset
(@) defaultObjectSet

Outliner: Select "5 onc/"Hai ule” Outliner: Select “bend2Handle”

SHAPES
bend2HandleShape

Curvature I14

INPUTS
i bend?2

Frivelnne

Curvature 40
Low Bound
High Bound

Curvature

Low Bound - =

High Bound 1 Wlth bOTh ”bEHdHaﬂdfeS” |n eﬁect, you
5 a

OUTPUTS
bend2

should achieve this floppy bun look.

Channel Box: Set Curvature to “40" Channel Box: Set Curvature to 14" Once verified, reset the curvature to "0’
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Creating Animation Controllers for the Burger King Model

ﬁ File Edit | Create Select Modify Display Windows Key

nation:

)
o ¥
Cutliner
Display Show Help

imageFlanel
top_bun
<%* bottom_bun
<» burger
g
ffa bend1Handle
Iffﬂ harcditande
0 nubsCided

delauitightet

Channels |Edit| Object Show

top_bun_cntrl

Translate ¥ 0
Transiate¥ 0O

Translate

5 Create

Polygon Primitives

Volume Primitives

Lights

Cameras

Curve Tools

Sweep Mesh

Type

EBifrost Graph

SVG

AdobelR) Hlustrator(R) Object...
Construction Aids

Construction Flane

Free Image Plane

Locator

Annotation...

Measure Tools
gement

Scene Description (USD)

Scene Assembly

Audio  Visualize Deform Constrain  MASH

4

Sphere
Cube
Cylinder
Cone
Flane
Torus

Square

Qoee DD

Interactive Creation

v Exit On Completion

(Sl = [B1 157 e el

Create a "Nurbs” circle.
Create> NURBS Primitives> Circle

Double click & rename: “top_bun_cntrl”

Poly Modeling Sculpting

0> @
4. 1. Have "top_bun_cntrl” selected.
2. Click "Hist" Delete History icon

3. OL..
4. Edit> Delete by Type> History

Edit Object Show

Translate X
Translate ¥

TranslateZ O

Rota
Rotate ¥
Rotate Z
Scale X
Scale ¥
ScaleZ
Visibility
SHAPES
top_bun_cntriShape
INPUTS
makeMNurbCirclel

e . P

2 a Change values:

Translate Y: 4,108
Scale X)Y.Z: 10.561

Channels Edit Object Show

top_bun_cntrl
Translate X
Translate ¥

SHAPES
top_bun_cntriShape

xog |PuuEy

xog |Euuey

— Freeze Transformations

1. Have your "top_bun_cntrl” selected.

2. Click on "FT" Freeze Transformation icon
3. Or.

4. Modify> Freeze Transformations
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top_bun_cntriShape

= Selected Focus Attributes  Display  Sh

nurbsCurve

' Show Hide

v Visibility Template
v/ LOD Visibility Always Draw On Top

1011p3 B3NquIY

Hide on playback Intermediate Object

Hidden In Qutliner

Use Outliner Color
Qutliner Color .
Ghosting Information
Bounding Box Information
Drawing Overrides
v Znable Overrides

Display Type MNormal i

Level of Detail  Full
v’ Shading
v Texturing
v’ Playback
V' Visible

Color RGB fuf

1_ Assigning Cu. “n: “owcisior Controllers .
]

Selection

A. Select the "top_bun_cntrl” e
B. Selec! (fie Attribute Editor Amoid
% Clckon “top_bun_cntriShape” tab e
. Click on “Object Display”, then Extra Attributes
E. Click on “Drawing Overrides”
F. Check "ON" for (Enable Overrides).
G. Set “Color” to RGB

H. Pick a color that you desire.
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— Grouping, Renaming, Edit Pivot, and Parent Contraints 3 -
s Clic

Display Show Help -

where
= T ( the rea circle

T Display Show Help Outliner

i [MEE how Help : LO Open up
- Group them. = " “group?, and

<, imagePlanel

T Edit> Group - see the contents.

*3* bottom_bun Or ShortCUt: L

«%* burger

iw_ <#-imagePlanel
2 king CTR |_+ g <% bottom_bun
i bend1Handle
/i bend2Handle

top_bun_cntri

«%* burger

«%* king

top_bun_cntrl

':o::' defaultLightSet _bun_cntrl

& groupl =
':o::' defaultObjectSet N JitLightset groupl

i bend2Handle

* fy bendirandie 3a ® Double click on “group?”
Select these together. Gataie Rename “group1”
(CTRL+left click select) to “top_bun_group”
“top_bun” —
“bendiHandle”

"bend2Handle”

Select “group1” ONLY from

the Outliner!

Now work ONLY work from
“front-Z" camera.

Press “d" to activate “edit pivot”,
Pull on (top arrow) handle to
move the pivot point directly

as show here,

\

[ |
"group!” and it's new
handle is now placed
much lower.




Channels Edit Object Show

top_bun_cr
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Understanding & Applying Parent Constraints

{0 [BUUEYD

top_bun_group

0}pT 1BAET [/ X

Visibility on

ntriShape

Nothing here.

Check for Mistakes
Double check your progress by
comparing it to my 3 examples.
Pay attention to what | highlighted.

Channels Edit Object Show

Channels  Edit

x0g [@UUBEYY

top_bun

frog EuueyD

10}pT Jase]
10)pg Jade

nAa

e i3r i Review:

The “fop_1un”, & “bendiHandle” &

enc - Handle’, all have to be grouped
together as (top_bun_group), because
.ne eformers will not work if they are
ot inside the bun at all times.

Reason Review:

Rigging relies hcavily on zerod out
coordinates &
related 10 defo
befc

ing construction history

.ations (bend deformers),
applying constraints.

Charninel Box should be free of (left-over)

age data created during your progression.

Reason Review:

The nurbs circle (top_bun_cntrl) will
be used as a selectable controller,
to be able to pick+select, and then
animate the (top_bun_group).

You can't physically select the
(top_bun_group) in the 3D world.
It's only possible from the Outliner.
Hence the need for a controller.

1. First, select the (top_bun_cntrl) because this controller will be the PARENT that controls & constrains

the child, (top_bun_group).
2. Next, you hold down the (CTRL) key, and (from the Outliner), also pick+select the (fop_bun_group).

varentConstrainti

3. Now do this: Constrain> Parent

4. If you followed directions correctly, your Outliner should look like this example shown here.
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Display '_-';hcuw Help

outine | Rigging "bottom_bun": Bend Deformers & Controller 2

: 1.

-

» a. Select the "top_bun_cntrl”
» b. Make a duplicate copy of it.
; c. Press: CTRL+d

d. Rename the copy to:

N— “bottom_bun_cntrl”

a2 top bun group

- top_bun_cntn

\#1) defaultlightset
() defaultObjectset

Poly Modeling Sculptiong Rigging wnimation Rendering

- M
wha Y
Channels Edit Object Show
bottom_bun_cntrl
Tranclata ¥ 0

Translate Y -10.432 " This information
e : needs to be wiy~d
potate out & reset back
to "0"
SHAPES MO dIfy of
bottom bun cnfrShape Freeze Transformations

L/ - _—
Channels Edit Object Show

benddHandle
Translate X
Translate

5. Creating 2nd 7' ¢ mei

B a Select "botic n
b. Creat~ 21 beric. deformer.
Daform> Nonlinear>
1 SHAPES
Bb [ bend4HandleShape .
Curvature 0
<. Now you should have s
' bendd
Jend4H8ndI‘€”. Envelope
Curvature 0
D. Set Rotate X, Z: 90 lowBound -

High Bound

r

. Werk rom the
ront-Z camera.
2. Lower the new
controller down
‘ so it rests on
the flat surface.

Channels Edit Object Show

bend2Handle
Translate X

g
m
=

SHAPES
bend2HandleShape
Curvature ID

¢ bottom_bun_cntrl
(#) defaultLightset
(@) defaultObjectset

INPUTS
0 E

Hlool GuiEpop

T
4 m Creating 1st Deformer

meees a Select "bottom_bun”
b. Create a bend deformer.
Deform> Nonlinear>
Bend
c. Now you should have
“bend3Handle”.
D. Set Rotate Z: 90
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“bottom_bun": Testing Bend Deformers & Grouping

3' Grouping
Y ottom_bun”

Cutliner

Display Channels Edit Object Show

bend2Handle
m{ Translate X
Translate
Translate
) Rotate
m{

tliner

isplay Show Help

i

m{
m{
m{

magePlanel

om_bun

1. Testing bend3 Deforme

<P imagePlanel
SHAPES

N T Bl a. Select “bend3H:.d! =" from Outliner.

¢ om_bun_cntrl INPUTS " )
(75 et = b. In Charnel Box, -2lect “be;1ad3”.
c. Input “. 0" for Curvature.

I";'Jfabendleandle Envelope 1
(@) defaultLightset L::!;:E:l; — | |
S Figh Sound 1 : d. Your mod=! should bend & look like this.
OUTPUTS

e e. Now reset e “Curvature” back to 0",

(CTRL+Select)

These items from Outline.
Then (group them).
CTRL+"g"

Cutliner
Display Show Help

m{
m{

Channels

SHAPES
bendd4HandleShape
Curvature IEID
INPUTS
bendd
Envelope 1
30

Low Bound -1
High Bound 1

Testing bend4 Deformer

a. Select “bend4Handle"” from Outliner.

b. In Channel Box, select “bend4”.

c. Input “30" for Curvature.

d. Your model should bend & look like this.

e. Now reset the “Curvature” back to “0".
T —

They should look like this.

Outliner
Display Show Help

m
=
-
=
. imagePlane1

er

bun_cntrl

yottom_br

a7 groupl
i benddHandle
i bend3Handle

<%» bottom_bun




Cutliner
Display Show Help

L}
L}
L}
L}
<= imagePlanel
«%* burger
«%* king
top_bun_cntrl
a7 top_bun_group
bottom_bun_cntrl
|| &7 bottom_bun_group
ff benddHandle
If;‘; bend3Handle
«%* bottom_bun

(&) defanltlightset

[ O O O
§ e O
ale # [

ol 2 dle Cl
pDre ’

B » »
B O|e AE Jaing art 014
DO 0 0 Re 0 010 PIvot & ¢) d

Constrain 1A Cach old elp
Outliner M File Edit Create Select g
1 Renaming the group snination v | Wi O
] - O
a. Double Click & Rename = O
Il n i Pole Vector O

groupT, as: = Rivet

[_[]

b. "bottom_bun_group”

c. Make sure it has:
“bend4Handle”
“bend3Handle”
“bottom_bun”

Grab this !@nd!e & pull down.

AN

<#-imagePlanel

«%* burger

<%* king
top_bun_cntrl

; top_bun_group
bottom_bun_cntrl

+ bottom_bun_grouy

(gl 11 t

Cutliner
Display Show Help

L}
<#-imagePlanel
«%* burger
<%* king
top_bun_cntrl
a2 top_bun_group
bottom_bun_cntrl
»  bottom_bun_group
If;‘; bend4Handle
If;‘; bend3Handle
«%* bottom_bun
|—0 bottom_bun_group_parentConstrz
(#1) defaultlightSet

Parent Constraint

a. Select "bottom_bun_cntrl”

b. (CTRL+ select) the "bottom_bun_group
c. Make sure you're on "Animation” Menu
d. Constrain> Parent

Open “bottom_bun_group”

Now you should see this extra item:
“bottom_bun_group_parentConstraint”
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